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Introduction 

 

About This Manual 
This manual applies to version 7.x of the Imecom Print-2-Image™ image printer driver software. This manual is intended for 
use as a guide for installing and configuring Print-2-Image. 
 

Copyright Notice 
© 2010 IMECOM GROUP, Inc. All rights reserved. No part of this document may be reproduced, transmitted, transcribed, or 
translated into any language in any form by any means without the written permission of Imecom Group, Inc. 
 
Imecom, the Imecom logo, Print-2-Image, P2i, Faxil, Faxil Mail are registered trademarks of Imecom Group, Inc. and 
Prologue Software Group. 
 
All other company, brand and product names are the property, trademarks, or registered trademarks of their respective 
holders. 
 
Information in this document is subject to change without notice and does not represent a commitment on the part of 
Imecom Group, Inc. The software and hardware described in this document is furnished under a license agreement or 
nondisclosure agreement. The software may be used or copied only in accordance with the terms of the agreement. It is 
against the law to copy the software on any medium except as specifically allowed in the license or nondisclosure 
agreement. No part of this manual may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and recording, for any purpose without the express written permission of Imecom 
Group, Inc. 
 

For More Information 
Since 1989, Imecom Group has been providing enterprise fax server solutions, network fax software, and image printer 
driver software to companies or all sizes across the world. For more information on Imecom Group and our product 
offerings, please visit http://www.imecominc.com or call us at +1 603.569.0600. 
 
Imecom Group, Inc. 
8 Governor Wentworth Highway 
Wolfeboro, NH 03894 
U.S.A. 
Phone: 603.569.0600 
Fax: 603.569.0609 
http://www.imecominc.com 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.imecominc.com/
http://www.imecominc.com/
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Before You Begin 

Overview 
Imecom’s Print-2-Image image conversion printer driver is actually two products in one: Print-2-Image is the versatile image 
printer driver for Windows that creates images in many popular file formats, combined with ShowFax, a Windows 
executable to view and annotate images. To further support document management and imaging systems, Print-2-Image 
creates very high resolution images. 
 
Print-2-Image can be used in a variety f ways, for a variety of things. Some common uses for Print-2-Image include the 
following: 

 Image Management and Archiving 

 Fax-On-Demand 

 Document Management and Document Imaging 

 Integrated Voice Response (IVR) 

 Communication Tool kits 

 E-Mail and Fax Distribution Systems 
 
Print-2-Image easily integrates with any Windows programming environment — just set the current printer to Print-2-
Image and print. The image format, resolution, paper size, orientation, and other features are easily programmable. 
 

General Prerequisites 
The prerequisites for installing the Imecom Print-2-Image software are as follows: 

 The host machine is running Microsoft Windows OS. Print-2-Image v7 supports Microsoft Windows Server 
2008/2003/2000 Standard, Advanced, Enterprise, and Terminal Server Editions, Microsoft Windows 
7/Vista/XP/2000 Workstation Editions, and Citrix. 

 You should be logged on to the machine designated to host the Imecom software using an account that has local 
administrator privileges. 
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1. Installation of Print-2-Image 

The procedure for a new installation of the Imecom Print-2-Image software is a simple one. This guide assumes that Setup 
will be performed using software downloaded from Imecom Group’s website. 
 
1. Locate and Run the Setup Executable file downloaded from the Imecom Group website. 

 
2. At the initial Welcome screen, click NEXT. 

 

 
 
3. Select the directory to which Setup will install the main Print-2-Image files and click NEXT. The default directory is 

C:\Program Files\Print-2Image. 
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4. Verify the installation settings and click INSTALL. 

 

 
 

5. A progress bar will display while Print-2-Image is being installed. 
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6. Setup will indicate a complete installation when all files have been installed. Click FINISH. 
 

 
 
You may verify the Print-2-Image installation by navigating to Widows Printers. To do this, click Start > Control Panel > 
Printers and Faxes (or Devices and Printers). A successful installation will have created the Print-2-Image printer here. 
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Multiple Print-2-Image Printers 
With Print-2-Image v7, it is possible to install multiple instances of Print-2-Image. Each Print-2-Image printer may have 
different configuration settings. 
 
To install more than on Print-2-Image printer, simply run the setup program again. 
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2. Configuring Print-2-Image 

Print-2-Image is installed as a Windows printer and therefore can be configured through the normal Windows Printer 
Control Panel. 
 
To get to Windows printer and Faxes, click Start > Control Panel and double-click Printers and Faxes (or Devices and 
Printers). A successful installation will have created the Print-2-Image printer here. 
 

Print-2-Image Properties 
To configure Print-2-Image, right-click on the Print-2-Image printer and choose Properties. You will see a series of tabs in 
the Print-2-Image properties. This manual provides an overview of the main Print-2-Image properties tabs. 
 

General Tab 
The General Tab simply displays general information about the Print-2-Image printer. To access the Print-2-Image settings 
tabs, click Printing Preferences. 
 

 
 

Ports Tab 
The Ports Tab displays the port used by the Print-2-Image software. The FXL0 port will have been created during Setup, and 
is used by default. 
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Output Tab 
The Output Tab is used to define the file output of the Print-2-Image driver. Here, you can specify file output format, define 
file naming conventions, and specify the destination output directory. 
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Image File Format: Select the desired file output format from the drop-down list box. The following file output formats are 
supported by Print-2-Image v7: 

 TIFF 

 PDF 

 JPG 

 GIF 

 BMP 

 PCX 

 DCX 
 
NOTE: If TIFF is selected, a second drop-down list box appears offering various choices for the type of TIFF file output 
desired. 
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File Name: Specify the desired File Naming convention/process to be used. Print-2-Image v7 
supports the following file naming: 

Manual: If selected, you will be prompted to enter a file name before the image is generated. 

Automatic: If selected, Print-2-Image will automatically name the image output file. This feature is 
typically used when an external application expects the same file name to be produced 
in the same directory every time Print-2-Image generates an image file. 
 
This option requires a complete path, e.g. c:\folder\filename.ext 
 
If the Automatic field is left blank, or the field only contains a drive letter and directory, 
Print-2-Image will attempt to build the file name from the source document name 
provided by Windows. The resulting name is typically the name of the application that 
printed the document. This only applies to the file name itself. The file extension is 
derived from the file output selected. 
 
If the Automatic field contains only a file name, Print-2-Image will use the file name 
specified, the appropriate extension, and the information specified in the “Default 
Directory” field under the Output Tab. 
 
If the “Default Directory” field under the Output Tab is left blank, Print-2-Image will use 
the Windows Directory. 

Automatic Sequential Number: If checked, a sequential number will be added to the file name. This is used when 
Automatic Naming is selected. 

Output: Specify the output settings for the image file. 



Product Manual - Imecom Print-2-Image v7.x 10      

 

Default Directory: This is the default directory to which image output files will be written. Any valid path is 
acceptable. This is the only editable field. 

Last File – Image Format: This is the format of the previous file generated by Print-2-Image. 

Last File – File Name: This is the file name of the previous file generated by Print-2-Image. 

Last File – Number of Pages: This is the page count for the previous file generated by Print-2-Image. 

Last File – Source Document: This is the source document used for the previous file generated by Print-2-Image. 

 
NOTE: An external application can also set a unique value for the Auto File Name option before printing by using the 
WritePrivateProfileString function, or by updating the registry. 
 

Document Tab 
The Document Tab is used to define document properties for the image file output of Print-2-Image. Here, you can specify 
the document orientation, resolution, paper format, and scaling of the image file output. 
 

 
 

Orientation: Specify the orientation for the image file putput. Portrait and landscape are the 
available orientations, with reverse landscape available for landscape 
documents/images. 

Resolution: Specify the resolution and paper format for the image file output. Print-2-Image 
supports the following resolutions: 

 200x100 

 200x200 

 600x600 
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Paper Format: Specify the paper format for the image file output. Print-2-Image supports the following 
paper formats  
 

 Letter 

 Letter Small 

 Legal 

 Statement 

 Executive 

 A4 

 A4 Small 

 A5 

 Folio 

 Note 

 Envelope 
 Envelope #9 

 Envelope #10 

 Envelope #11 

 Envelope #12 

 Envelope #14 

 Envelope DL 

 Envelope C5 

 Envelope C6 

 Envelope C65 

 Envelope B5 

 Envelope B6 

 Envelope Monarch 

 6 ¾ Envelope 

 
 

Rescaling: Specify DPI rescaling for the image file output. You may rescale the DPI for X and Y, or 
length and width. This feature is useful when printing from an application that does not 
support prnting non-square 200x100 DPI. 

 

Overlay 
The Overlay Tab is used to define an overlay file to be added to the image file output. The overlay file will appear on top of 
the original document when the image file is generated. 
 

 
 



Product Manual - Imecom Print-2-Image v7.x 12      

 

Activate Overlay: Check this to activate the overlay option. 

First Page Only:  Check this to add the overlay file to only the first page of a multi-page document. 

Reduce/Enlarge if Necessary:  Check this to reduce or enlarge the overlay file as needed. 

Portrait Image:  Specify the image overlay file for image output files using portrait orientation. 

Landscape Image:  Specify the image overlay file for image output files using landscape orientation. 

 

Advanced 
The Advanced Tab is used to define advanced custom settings for the image file output of Print-2-Image. Here, you can set 
custom page length and width values, and define a custom page file mask. 
 

 
 

Custom Page Length: If selected, this truncates the bottom part of the image output file according to the 
number of pixels specified.  

Custom Page Width: If selected, the image output width will be set to the number of pixels specified. 

Truncate Lines From Top: if selected, this will remove the number of pixels specified from the top of the image 
output file leaving only white space. 

Start Counting Single Page 
Numbers From 1: 
 
Single Page File Mask: 

This is a string of text used to controls the naming of single-page image files. The field 
arguments correspond to the base filename, page number, and file extension. Each field 
argument is preceded by a % symbol: 

 %N = base filename 

 %P = page number 

 %E = file extension (without a “.”) 
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Consider the case when P2I is outputting page 45 of a file that is nominally called 
“output.tif” 

 The base filename is “output” 

 The page number is “45” 

 The extension is “tif” 
 
A SinglePageFileMask that is “%N-%P-%E” would result in “output-45-tif”. This example 
is not necessarily ideal as this filename has no extension. Instead you might consider a 
SinglePageFileMask of “%N-%P.%E” which would result in “output-45.tif” 
 
Optionally, between the % symbol and the field specified, you can have numbers in the 
form of “X.Y”, where X is the minimum width and Y is the maximum width of the field. 
Both X and Y are optional - if you omit Y you may omit the ‘.’ as well. If X is prefixed with 
a 0, then 0’s are filled in to pad the value to the minimum width, if required. 

 
Here are several examples of SinglePageFileMasks – all of these examples assume you’re printing page 45 of a file named 
“output.tif” 
 

SinglePageFileMask Output filename 

%.5N%03.3P.%E  outpu045.tif 

%.4N%.3P.%E  outpu45.tif 

Page-%N%03.3P.%E  Page-output045.tif 

Test%P.%E  Test45.tif 

%N(%P).%E  output(45).tif 

%f%x%N%d%P.%E  %f%xoutput%d45.tif 

%.4Np%03.3P.%E  outpp045.tif 

 
NOTE: The last entry (“%.4Np%03.3P.%E”) is the default SinglePageFileMask. It’s output corresponds to the default 
SinglePageFileMask of the previous version of Print-2-Image. 
 

Print Mode 
The Print Mode Tab controls the Application Programming Interface (API) options used in launching applications. This tab is 
typically used for defining programming functions. 
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Application Interface: This controls what the method of communication used between print-2-Image and other 
software applications. 

 None: No communication method is used. 

 Mode 1: Only launch the application 

 Mode 2: Communicate with the application via Windows Messaging 

 Mode 3: Communicate with the application via Win32 Events 

Launch Application: This controls how Print-2-Image interacts with the Application Interface feature. When a 
communication is received, based on the Application Interface option, Print-2-Image can 
launch an application: 

 Never 

 When a window is not found (if the application is not already running) 

 Always 

Viewer: This controls what software program is used to view the image files generated by Print-2-
Image. 

 Associated: Select this option to use those applications set as default through the 
Microsoft Windows operating system software 

 External: Specify a program to use for viewing image files generated by Print-2-Image 

 Use Window Title: Detect if the application is already running based on Window Title 

 Use Window Class: Detect if the application is already running based on Window Class 

 Window Text: Detect if the application is already running based on the Window Text 
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Print Events: The Print-2-Image OCX Module can send three (3) events to an application: 

 Start: StartPrint notifies the application that a print job has been started. 

 End: EndPrint notifies the application that a print job has completed. It is required that 
this text box contain information in order for Print-2-Image to launch an external 
application. 

 Abort: AbortPrint notifies the application that a print job has failed. 

 

About 
The About Tab provides information on the Print-2-Image version installed as well as information about Imecom Group, Inc.  
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3. Imecom ShowFax TIFF Viewer  

Print-2-Image includes the Imecom ShowFax viewer software used for viewing TIFF image files. Print-2-Image can be 
configured to use ShowFax as the default application for viewing TIFF image file output, or you may elect to use a different 
program, e.g. Windows Picture and Fax Viewer. 
 
The ShowFax executable file (shwfax32.exe) is located in the Print-2-Image installation directory. ShowFax is included with 
the Print-2-Image product free of charge. 
 

Tool Box 
The Tool Box is displayed as a Short menu by default. The Short menu does not contain all available commands for the Tool 
Box. To switch to Long Menu, click Options > Long Menus. 
 
 

View Full Page 

 

Zoom 

Move Frame Copy Selected 

Rotate 0° Rotate 180° 

Rotate 270° Rotate 90° 

Pointer Insert Text 

Insert Arrow Insert Frame 

Previous Page Next Page 

Print Save 

 

File Menu 
 

 
 
The following commands are available in the File Menu: 
 

New: You can create a new image directly from the View module by typing a note with the ‘annotation’ feature, or 
by using ‘Paste’ from the Clipboard. 

Open: The Open command is used to retrieve archived images. 

Save: Use this command to save the image being viewed. An option will be available to convert objects to images or 
keep them separate. 

Save As: This command allows you to save the image being viewed under a new name, and optionally in a new format. 

Print: This command prints the image being viewed on any network printer. ‘annotation’ feature, or by using ‘Paste’ 
from the Clipboard. 

Exit: Closes the viewing application. 
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Edit Menu 
 

 
 
The following commands are available in the Edit menu. 
 

Cut: This command cannot be used with an image file as it is a single graphic file, but Annotation 
(detailed later in this chapter) provides a means to cover and replace any area on the image.  
Cutting part of an image can be resolution sensitive. It is better to copy from the Zoom view. 

Copy: Outline the area to be copied to the Clipboard, then either select Copy from the menu, or click the 
Copy icon from the Tool Box. 

Copy to Signature: Creates a signature file. 

Paste: Choosing this command will copy whatever is on the Clipboard to the upper left-hand corner of the 
View module. The material can be imported from any image or other Windows document. It will be 
displayed in a frame, which can be altered to fit the text or graphics. To move the frame, hold down 
the left mouse button and drag the frame where you want it to appear on the page. 

Paste a Signature: Adds a signature to a document being viewed. 

Delete: Deletes the object selected with the pointer tool. 

Select All: When chosen in the menu, all annotated items are selected. 

 
To create a signature file: 

1. Use the View module to display an image with the signature on it. 
2. Click the Scissors icon, then click and drag to outline an area around the signature. The signature is now enclosed 

in a dotted rectangle. 
3. In the menu, select Copy to signature. 
4. Enter a filename for the signature file. 

 
To add a signature: 

1. Make sure that the signature file has already been created. 
2. Display the document on which to add a signature. 
3. From the menu select Paste signature. 
4. Select the signature file to paste and click OK. 
5. Click and drag the signature to move it to the appropriate part of the image. 
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Page Menu 
 

 
 
This following commands are available in the Page menu: 
 

View: Sub-menu - When selected the following options are available: 

 Whole page: The first view of a ‘newly received’ or ‘archived’ image shows a full page view. This 
allows easier identification of an area to be selected for magnification. The Whole page view icon will 
return to the full page view any time you click the icon on the upper left of the Tool Bar. 

 Width: This view expands the screen image to fill the available space. It can be selected from this 
menu or by clicking on the right mouse button. 

 Real size: This view shows a portion of the image at actual size. For a full screen view of the image, 
Maximize the window to expand the View module to full screen. 

 Zoom: This option magnifies a selected area, from any other view, for closer inspection. 

Rotate: Sub-menu - When selected the following options are available: 

 0° 

 90° 

 180° 

 270° 

Previous: View the previous page. 

Next: View the next page. 

Go to: Enter the page desired, or open the drop-down list and select the appropriate page. 

Insert: This command automatically inserts a blank page at the point in the image that is being viewed. These 
pages can be used for material moved from elsewhere in the image, or for material copied from other 
documents or files ‘dragged and dropped’ from the Windows Explorer. 

Add: Insert a blank page at the end of the image. 

Delete: Delete the current page being viewed. 
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Tools Menu 
 

 
 
The following commands are available in the Tools menu: 
 

Zoom: Enlarges a part of the image. Position the magnifying glass on the area to be enlarged and click once on 
the left mouse button to go to the first level of enlargement. Click a second time for maximum 
enlargement. To go back to the first level, click on the left mouse button, or on the right mouse button 
to select the desired size. 

Move Image: This command allows you to grab and move the image quickly within the screen view being displayed. 
When moving the image a short distance, the scroll bars provide an alternative. 

Select Image: This command enables you to select the image being viewed. 

Copy Image: This command enables you to crop the image being viewed. 

Copy Margins: This command enables you to crop the margins of the image being viewed. 

Pointer: This command is used to select previously annotated material (text, frames, arrows or pasted material). 

Text: This command displays a + symbol on the screen. Use the plus sign to select the area you wish to outline 
for annotation. 

Arrow: Place this plus sign where you wish to begin the line and hold the left mouse button down while you 
extend it to the other point of reference. 

Frame: This command will display a + on the screen. Place the plus sign where you wish to begin the frame, and 
hold the left mouse button down while you enclose the required area. 

Background: This provides a selection of backgrounds for Frame or Text annotation: 

 Transparent: Shows the material beneath the area covered. 

 Black: Turns the frame black. 

 White: Blanks out the area beneath the frame and, in Text mode, makes it possible to overwrite 
the text on the image. 

Line: This provides a selection of eleven formats for the frame and arrow lines for text annotation including: 

 None: Causes the lines to disappear. 

 Dotted: Outlines the area with dots. 

 Filled: Outlines the area with long dashes. 

 Dash - Dot: Long dashes separated by a single short dash. 

 Dash - Dot - Dot: As above but separated by two short dashes. 

 Density 1 to 8: An increasing range of line thicknesses. 
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Options Menu 
 

 
 
The following commands are available in the Options menu: 
 

Tool Box: Tool Box: can be attached to the inner, or outer, left-hand corner of the View module, can be 
closed when not in use, or can be movable within the module. 

 None: The Tool Box is closed. 

 Floating: The Tool Box is outside the viewing area when opened, and inside if the module 
is expanded, using the Windows Maximize button. A Tool Bar Grabber appears, upper 
right, in this mode that allows you to grab and drag the Tool Box to another location. 

 Fixed: The Tool Bar is in the upper left hand corner of the View, reducing the viewing 
area when the view is not maximized. 

Enhance Black: Increases the darkness of a viewed image. 

Reverse Image: Text and graphics appear in white and background in black. 

Settings: Saves the environment settings of the viewing module either immediately or when exiting the 
program. 

Short Menu/Long Menu: The menu changes depending on the selection. The short menu does not show the annotation 
icons on the Tool Bar. 
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4. OCX Module  

Information regarding the initial setup of the OCX module is available in Chapter 2 under the Print Mode section. Basic 
information about setup is provided here. 
 

Configure the OCX Module 
 

 
 
In order for the OCX module to work properly, you must set the following parameters: 
 

Application Interface: Set to 2 or 3 (2 is preferred). 

Use Window: Set to Class. 

Window Text: Enter P2i32Not 

Start Print: Enter WM_P2I_STARTPRINT 

End Print: Enter WM_P2I_FILE_CREATED 

Abort Print: Enter WM_P2I_FAILED 

 
It is suggested to also run at least one print job after installing Print-2-Image to ensure that all settings are placed in the INI 
file. 
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OCX Test 
You can check to make sure your OCX module has been setup correctly by using the OCX test files which are delivered with 
Print-2-Image. 

1. Unzip the ocxtest.zip file into a directory 
2. Set the Program File path to the location of the ocxtest.exe file 
3. Set Launch App equal to “When window not found” or “Always”. 

 
NOTE: If you intend to use batch printing, it is highly recommended that the Print-2-Image events be used. This will help 
avoid Faxil Error -10 errors. 
 

Visual Basic Setup 
In order to use the OCX module in a Visual Basic application, the module must first be added to the application’s form. To 
do this, follow these steps: 
 

1. Right click on the Toolbox and click Components. 
2. Select the “Fax Resource P2I Interface Control”. 
3. The Print-2-Image OCX module now appears in the Visual Basic Toolbox. Click the P2I button and add the OCX 

control to your form. 
 

You have successfully added the P2I OCX module to your form and can now program using Print-2-Image. 
 
NOTE: If you download or receive a new version of Print-2-Image, be aware you may have to replace the OCX module in 
your form with the newer version. This applies only if revisions have been made to the newer Print-2-Image version. 
 

OCX Properties in Visual Basic 
The following Print-2-Image properties are available to the OCX module. 
 
NOTE: The OCX module does not provide a way to print documents, it only facilitates between the driver and your 
applications. 
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Property Value Purpose 

AutoFileName File name and path Selects the name and path of a file 

BllsWhite Numeric Reverse Video Mode 

CustomPixelLength Numeric When enabled, sets image length 

CustomPixelWidth Numeric When enabled, sets image width 

FileFormat File format name Sets file format type 

FillOrderLeastSigBit True/False Sets TIFF file’s Least Significant Bit 

ImageOverlayAllPages Numeric Applies image overlay to all pages 

ImageOverlayFileLandscape File name and path Location of landscape file overlay 

ImageOverlayFilePortrait File name and path Location of portrait file overlay 

ImageOverlayFileStretchToFit File name and path Specifies whether to stretch the overlay 

LastDirectory Directory path Specifies default file directory 

LastFileFormat Numeric Format of last file 

LastFileNumPages Numeric Page count of last file (if multi-page) 

LastFileSource String Name of last source file 

RenameSinglePage True/False Specifies renaming of single pages 

SinglePageCountFrom1 True/False Sets staring numbering at 0 or 1 

SinglePageMask String SinglePageFileMask 

SkipTopPixels Numeric Removes top pixel from an image 

UseAutoFileName True/False Specifies AutoFileName use 

UseCustomLength True/False Specifies CustomPixelLength use 

UseCustomWidth True/False Specifies CustomPixelWidth use 

UseSkipFromTop True/False Specifies SkipTopPixels use 
 
See Chapter 2 Section Print Mode for more information on how these properties work. 
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File Format Values 
 

File Name OCX Name Numeric Value 

DCX DCX 11 

PCX – single page PCX 10 

PNG – single page PNG 51 

TIFF Huffman – single page TIF_HUFFMAN 8 

TIFF T4 TIFFT4_G31D 4 

TIFF T4 – 2d TIFFT4_G32D 6 

TIFF T4 – IFO TIFFT4_G31D_IF 13 

TUFF T4 – 2d IFO TIFFT4_G32D_IF 15 

TIFF T4 Gammalink G3 – single page TIF_GAMMA_G31D 19 

TIFF T4 Gammalink G3 2d – single page TIF_GAMMA_G32D 20 

TIFF T6 TIF_G41D_IF 5 

TIFF T6 – IFO TIFFT6_G41D_IF 14 

TIFF T6 – single page TIFFT6_G41D 21 

PDF PDF  

GIF GIF  

JPG JPG  

BMP BMP  
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5. INI File Attributes 

Print-2-Image stores all settings and configuration information in an .INI file. The .INI file is C:\users\<current 
user>\AppData\Local\ and is created only after the first print job is sent to the Print-2-Image 7 printer. 
 
Below is an example of a typical P2Image.ini file. 
 
NOTE: This is only an example. Your P2image.ini file may look different than the example. 
 
[AutoFileMode] 
AutoFileName=  (Path and name of Auto File Name) 
UseAutoFileMode=0  (Selects whether Auto File Name is on or off) 
[FileOptions] 
UseSequentialFileNumber=0  (Selects whether Sequential Numbering is on or off) 
SequentialFileNumber=0  (the next number to be used when Sequential Numbering is Enabled) 
FileFormat=55  (Current value of the File Format selected in properties) 
ReverseLandscape=0  (Selects whether Reverse Landscape is on or off) 
DoRescale=0  (Selects whether Rescaling is on or off) 
RescaleXDPI=600  (Horizontal value of Rescaling in pixels) 
RescaleYDPI=600  (Vertical value of Rescaling in pixels) 
UseCustomLength=0  (Selects whether the Custom Pixel Length feature is on or off) 
UseCustomWidth=0  (Selects whether the Custom Pixel Width feature is on or off) 
UseSkipFromTop=0  (Selects whether the Skip From Top feature is on or off) 
CustomPixelLength=2200  (Value in pixels of the Custom Pixel Length) 
CustomPixelWidth=1728  (Value in pixels of the Custom Pixel Width) 
SkipTopPixels=800  (Value in pixels of the Skip From Top option) 
SinglePageCountFrom1=1  (Value to start the single page count from) 
SinglePageMask=%N_(page_%03.3P).%E  (Format of the Single Page File Mask) [Output] 
LastDirectory=C:\Users\phillip.IMECOM.US\Desktop\  (Last Directory printed to) 
LastFileFormat=  (Last format printed) 
LastFileName=  (Name of the last file printed) 
LastFileNumPages=  (Number of pages of the last printed document) 
LastFileSource=  (File path of the last file printed) 
LastFileError=1  (Last error reported) 
LastUser=Phillip 
[ImageOverlay] 
UseImageOverlay=0  (Selects whether Image Overlays is on or off) 
ImageOverlayAllPages=0  (Selects whether Image Overlays is applied to all pages or just the first page) 
ImageOverlayStretchToFit=0  (Selects whether Image Overlays are stretched to fit images) 
ImageOverlayFilePortrait=  (Path of the Portrait Image Overlay) 
ImageOverlayFileLandScape=  (Path of the Landscape Image Overlay) 
[PrintModeOptions] 
PrintMode=1  (Value of the communication method used to communicate with applications) 
LaunchMode=2  (Value of the instructions Print-2-Image uses to open applications) 
StartPrintEvent=  (Start Print Event Value) 
EndPrintEvent=end  (End Print Event Value) 
AbortPrintEvent=  (Abort Print Event Value)        
WindowTitleMode=1  (Selects the method used to communicate with applications) Viewer=1 
WindowText=P2i32Not  (Window Text / Class value) 
ViewerApp=C:\Program Files (x86)\Print-2-Image7\Shwfax32.exe  (Path of the application launched by Print-2-Image) 
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6. Uninstall Print-2-Image 

Print-2-Image can be uninstalled through Windows Add/Remove Programs in the windows Control panel. 
 
1. Open Windows Control Panel > Add/Remove Programs. 

 
2. Locate Print-2-Image in the list of programs, and choose Remove. 
 

 
 
3. A progress bar will display. 
 

 
 
4. When Print-2-Image has been completely uninstalled, you will be prompted to reboot your machine. Click Yes to 

reboot. 
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7. Errors 

InstallShield Errors 
 

 
Error: 
An error occurred during the move data process -112 
Component P2ISystemFiles 
File Group P2ISystemFiles 
File d:\p2i6-windows\p2i6u.dll (example) 
 
Cause: 
Installation files have been changed, tampered with, or corrupted. 
 
Solution: 
If you have replaced any installation files prior to installation, you must restore the original files and 
reinstall. If you have not replaced any files, please contact your Print-2-Image provider for new installation 
files. 
 

 
Error: 
An error occurred during the move data process -113 
Component P2ISystemFiles 
File Group P2ISystemFiles 
File d:\p2i6-windows\ocxtest.zip (example) 
 
Cause: 
This error is caused by a file not being in the proper location during installation. 
 
Solution: 
In most cases this error is caused after downloading a zip file and failing to decompress it with 
subdirectories. To fix this problem decompress Print-2-Image again, but make sure that the option 
“Create Subdirectories”, “Create Directories”, or “Recourse Directories” (depending on decompression 
utility) is selected, then run the installation again. 
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Error: 
“An error occurred during the move data process: -115. 
Component: P2I System Files. 
File Group: P2I System Files. 
File: C:\Winnt\System32\Tcdll32.dll” (example) 
s 
Cause: 
This error is caused by a file being locked during installation. 
 
Solution: 
In most cases this problem occurs during an upgrade of Print-2-Image. Typically either Tcdll32.dll or 
transcod.dll will be locked by the system. To stop this error either: 

1. Uninstall any old versions of Print-2-Image, reboot, and reinstall. 
2. Stop the Windows Spoolers service (Windows NT and 2000), delete the affected file, and 

reinstall. 
 

 
Error: 
“An error occurred during the move data process: -119. 
Component: P2I System Files. 
File Group: OCX. 
File: C:\Program Files\Imecom\Print-2-Image 6 Trialware\p2i32.ocx 
 
Cause: 
This error is caused by Install Shield being unable to register the OCX file with Windows. 
 
Solution: 
This problem typically occurs with Windows 95 A workstations missing newer files for OCX installation. To 
solve this problem either: 

1. Install Internet Explorer 4.x or greater. 
2. Install Microsoft’s OLEUpdate.exe file available from Microsoft or from Imecom’s website at 

http://www.imecominc.com/ 
 

 
Error: 
The Installation seems to hang after the initial status bar 
 
Cause: 
Install Shield is attempting to communicate with other open applications to see if another instance of 
itself is running. 
 
Solution: 
Stop Microsoft Outlook if it is running, and any other non-critical applications and the installation should 
continue; OR wait a few minutes and the installation will continue on its own when Install Shield times-
out with its inter-application communication. 
 

 
 
 
 
 Appendix B 
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Print-2-Image Installation Errors 
 

 
Error: 
ERR_FAXIL_FAILED 
Installation of the Printer Driver Sub-system has failed. Please contact Technical Support. 
 
Cause: 
This error is caused by Print-2-Image being unable to access / stop the Spoolers service, write to the 
registry, or you are using a version which cannot support the German Language. 
 
Solution: 
This problem occurs on occasion because Print-2-Image has to shut down the Spoolers /Print Spoolers 
service when installing, in order to register itself as a printer driver. If the Spoolers service is in use or 
there are restrictions on the registry during installation this error message will appear. To solve this 
problem either: 

1. Wait a few moments and attempt installation again. 
2. Manually stop the spoolers service and attempt installation again. 
3. Make sure that the account logged into the computer has the rights to add a printer or is an 

administrator account, and can make changes to system32 files and registry (Print-2- Image adds 
driver files to the C:\WINNT\system32\ directory and one or two subdirectories).  

4. Stop any anti-virus software or other programs which may prevent registry changes. 
5. Upgrade your version of Print-2-Image, if you’re running on a German OS. 

 

 
Error: 
RegDBCreateKeyEx failed to: 
Software\Microsoft\WIndowsNT\CurrentVersion\infilemapping\p2image.ini 
 
Cause: 
The user account installing Print-2-Image does not have rights to write to the registry. 
 
Solution: 
Add the rights to install a Printer or Administrator rights to the user account and reinstall. 
 

 
Error: 
ERR_INVALID_INF_FILE 
 
Cause: 
Print-2-Image has a corrupt installation file, or cannot properly read the installation file. 
 
Solution: 
Contact your software provider for a new version of Print-2-Image. 
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External Application Errors: 
 

Cerner/DHT CoPath Software 
 

 
Error: 
Open printer failed error 2 (followed by) 
Fax installation failed, contact technical support error -4 
 
Cause: 
An incorrect build of Print-2-Image exists on the installation CD. 
 
Solution: 
Contact your software provider for a correct version of Print-2-Image. 
 

 

Usage Errors 
 

Print-2-Image Errors 
 

 
Error: 
When printing from Microsoft Word, Print-2-Image “freezes” when manual file naming is used. 
 
Cause: 
Microsoft Word has a feature called background printing that pushes dialog boxes to the background. 
When using manual file naming Print-2-Image displays a dialog box, which will be pushed to the 
background by Microsoft Word, making it appear to “freeze”. 
 
Solution: 
Add the rights to install a Printer or Administrator rights to the user account and reinstall. 
 

 
Error: 
ERR_INVALID_INF_FILE 
 
Cause: 
Print-2-Image has a corrupt installation file, or cannot properly read the installation file. 
 
Solution: 
There are two possible solutions: 

1. On the menu bar select: Tools then Options. In the window which opens select the Print tab then 
unclick the background printing checkbox. 

2. Change the following registry key to 0. 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Word\Options\BackgroundPrint 
 

NOTE: If you are not experienced with editing the Windows Registry, DO NOT perform option 2. Have an 
experienced professional change the registry, or use Solution 1. 
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Error: 
I want to use the .ini file instead of the registry for Windows 2003, XP, 2000, or NT. 
 
Solution: 
Delete the following key from the registry: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\IniFileMapping\p2image.ini 
 

 
Error: 
Print-2-Image crashes when I print documents with printer code. 
 
Cause: 
Since Print-2-Image is an image driver, some printer code is incompatible with Print-2-Image and causes it 
to behave inappropriately. 
 
Solution: 
Refrain from printing documents with printer code. 
 

 
Error: 
Faxil Error -1 
 
Cause: 
This is a general failure error, and as such varies by computer. 
 
Solution: 
Please set up Error Logging, and send any generated logs, sample files, and a description of how to 
replicate this problem (if known) to your software provider. 
 

 
Error: 
Faxil Error -10 
 
Cause: 
This problem is caused by Print-2-Image being unable to access or move a file during the print process. 
 
Solution: 
There are four possible solutions: 

1. If using Print-2-Image programmatically be sure that you are using the events to control when 
printing begins. 

2. Close any open image files with the same name as the file you are printing. 
3. If using the SinglePageFileMask, make sure the format entered assigns a unique name to each 

image created. 
4.  If you are using an older version of Print-2-Image, avoid printing blank pages. 

 

 
Error: 
I want to remove the ShowProgress Box to make printing transparent to the user. 
 
Solution: 
Add the following key to your registry: 
[HKEY_CURRENT_USER\Software\Print-2-Image\FileOptions]“ShowProgress”=”0" 
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Error: 
System Error &H80004005 (-2147467259). 
Unspecified Error 
Seen with ocxtest.exe 
 
Cause: 
This version of the ocxtest.exe file has become outdated. 
 
Solution: 
Download a new Print-2-Image trialware or production software from our website at the address 
http://www.imecominc.com/ or contact Imecom Group for a new version of this file. 
 

 
Error: 
I try to print using Print-2-Image, but I get no output, and no error messages. 
 
Cause: 
There are three reasons for this problem: 

1. You are using Print-2-Image with Terminal Server or Terminal Services. 
2. The trialware image has been corrupted, tampered with, or deleted. 
3. Popup dialog boxes on errors was disabled during installation. 

 
Solution: 

1. Certain older versions of Non-Terminal Server Print-2-Image do not properly report not being 
allowed to run on Terminal Server / Services. If you have this version on a Terminal Server or 
have Terminal Services enabled, you will need to upgrade. 

2. Replace or restore the trialware image or reinstall Print-2-Image. 
3. Set the value of the following key to 1, then reprint a document and note the error code. 

HKEY_LOCAL_MACHINE\SOFTWARE\Imecom\Print-2-Image 6\ShowMessageBoxes 
 

 
 
 
 
 
 
 
 
 
 
Appendix A - Error Codes and Solutions 
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External Application Errors 
 

COPIA FaxFacts Software 
 

 
Error: 
Images created by Print-2-Image crash COPIA FaxFacts 
 
Cause: 
COPIA FaxFacts cannot support TIFF T6 images. 
 
Solution: 
Use Tiff T4 file formats (Imecom suggests Gamma T4 G3 Single Page). 
 

 
 

Gammalink Software 
 

 
Error: 
Error 4511 
 
Cause: 
Gammalink software requires that images be either 1728 or 2248 pixels wide. 
 
Solution: 
Check the CustomPixelWidth check box in Print-2-Image properties and set the width to 1728 pixels or 
2248 pixels or use the Gamma T4 G3 Single Page output file format. 
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Miscellaneous Software 
 

 
Error: 
My software cannot fax or view an image I create with Print-2-Image. 
 
Cause: 
There are four possible causes: 

1. My fax software does not like the resolution of my images. 
2. My fax software reports that the image has an invalid width. 
3. My software does not read my image, or says it has an invalid format. 
4. My software or server won’t open multi-page tiff images. 

 
Solution: 

1. When faxing any images, they typically must be either 200 x 200 or 200 x 100 resolution. There is 
now a newer standard where 400 x 400 DPI images are acceptable by some fax machines, and 
servers, but not yet all of them. 

2. If your faxing software uses Gammalink drivers or boards, the image must have a width of either 
1728 or 2248 pixels. If images do not have this width, Gammalink software will often return an 
Error 4511. 

3.  Some software is incompatible with compressed TIFF images, in particular TIFF T6. If TIFF T6 
formats do not work, try TIFF T4. If your software has trouble with TIFF T4, TIFF Huffman, DCX, or 
PCX format, should work, as they are uncompressed formats. 

4. Some software programs don’t like multi-page TIFF images, and can’t open these formats. In this 
case, use single-page TIFF images instead. 
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8. Imecom Documentation and Support 

Documentation 
Documentation for the Imecom Print-2-Image software and other Imecom products is in PDF format and located in the 
Documentation folder on the Imecom Group, Inc. Web site at: http://www.imecominc.com/support/manuals.shtml 
 
 

Technical Support Services 
Imecom Group provides technical support services to each customer that has purchased an annual Imecom Support Plan. 
Technical support services are provided via telephone, email, and remote connection to the machine hosting Print-2-Image. 
 
In addition, the Support section of the Imecom Group, Inc. Web site contains a wealth of information on Imecom products, 
product support, announcements, FAQs, and more. The Support section is located at: 
http://www.imecominc.com/support/ 
 
 

Contact Imecom Group, Inc. 
 
U.S. Headquarters 
Imecom Group, Inc. 
8 Governor Wentworth Hwy 
Wolfeboro, NH 03894 
U.S.A. 
http://www.imecominc.com 

Sales & General 
Phone: 603.569.0600 
Fax: 603.569.0609 
imecomsales@imecominc.com  
 

Support 
Phone: 603.569.0600 
Fax: 603.569.0609 
igisupport@imecominc.com  

 
 

http://www.imecominc.com/support/manuals.shtml
http://www.imecominc.com/support/
http://www.imecominc.com/
mailto:imecomsales@imecominc.com
mailto:igisupport@imecominc.com

